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1-1. Installation (NMRView C-version)1-1. Installation (NMRView C-version)1-1. Installation (NMRView C-version)1-1. Installation (NMRView C-version)

The following 3 files are required for installation of MagRO;

nmrview_5_x_x.tar.gz (NMRView ver5.2.2 or later)

protein.seq (sequence file. 1-letter code)

MagRO_NMRView_v1.18.x.tar.gz

1) copy and extend the compressed NMRView file at somewhere in your home directory;

cp /home/naohiro//nmrview_5_x_x.tar.gz ~/
tar xvzf nmrview_5_x_x.tar.gz

After that, change the directory name as you want;

mv nmrview nv_protein

nv_protein/matrix is going to be a working directory.

Place all of the spectrum data under the nv_protein/matrix

2) Next, copy and extend MagRO_NMRView_v1.18.x.tar.gz at somewhere in your home directory.

  For example;

       cp MagRO_NMRView_v1.18.18.tar.gz  ~/bin
cd ~/bin

       tar xvzf MagRO_NMRView_v1.18.18.tar.gz

Then, move to the MagRO directory,

cd  ~/bin/MagRO_NMRView_v1.18.18

You will find a text file whose name is run_temp_C.csh. Open the file with text editor, then edit the following

line as you have set up for your data;

setenv NKDIR /home/naohiro

setenv MGFIR MagRO_NMRView_v1.18.18

setenv NMRVIEW5HOME $NKDIR/nv_protein

After that, copy the file to your home directory and change the name of the file as you can see easily what it

work for;

cp run_temp_C.csh ~/run_protein_C.csh

Now you are ready to start MagRO_NMRView.

Type the file name to start the program;

./run_protein_C.csh

If you find error message, please check the permission of the csh file firstly.
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1-1. Installation (NMRView Java-version)1-1. Installation (NMRView Java-version)1-1. Installation (NMRView Java-version)1-1. Installation (NMRView Java-version)

Before the installation of MagRO, you have to complete the installation of NMRViewJ.

The following 2 items are required for installation of MagRO;

nv_protein (Project diretory)

protein.seq (sequence file. 1-letter code)

MagRO_NMRView_v1.18.x.tar.gz

Make diretory "matrix" under the nv_protein directory

mkdir nv_protein/matrix

nv_protein/matrix is going to be a working directory.

Place all of the spectrum data under the nv_protein/matrix

2) Next, copy and extend MagRO_NMRView_v1.20.x.tar.gz at somewhere in your home directory.

  For example;

       cp MagRO_NMRView_v1.20.18.tar.gz  ~/bin
cd ~/bin

       tar xvzf MagRO_NMRView_v1.20.18.tar.gz

Then, move to the MagRO directory,

cd  ~/bin/MagRO_NMRView_v1.20.18

Please find "run_temp_J9.csh" in the MagRO directory.

Open the file with text editor, then edit the following lines as you have set up for your data;

setenv MAGDIR     /home/nmruser/MagRO_NMRView_v1.20.18

setenv NMRVIEWJ  /home/nmruser/NMRViewJ

setenv NVDIR       /home/nmruser/nv_protein

MAGDIR, NMRVIEWJ and NVDIR specify the MagRO directory, installed NMRViewJ directory and project

diretory, respectively.

After that, copy the file to your home directory and change the name of the file so that you can see easily

what it is;

cp run_temp_J9.csh ~/run_protein_J9.csh

Now you are ready to start MagRO_NMRView.

Type the file name to start the program;

./run_protein_J9.csh

If you find error message, please check the permission of the csh file firstly.
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1-2. How to add new project1-2. How to add new project1-2. How to add new project1-2. How to add new project

1) For NMRView C-version, you can easily to add new project by copying and extending

nmrview_5_x_x.tar.gz file.

cp nmrview_5_x_x.tar.gz ~/

tar xvzf nmrview_5_x_x.tar.gz

mv nmrview_5_x_x nv_protein2

For NMRView Java-version, you have to create project directory such as "nv_protein2".

If you don't find matrix directory in the uncompressed directory, you have to create it;

mkdir nv_protein2/matrix

  

2) Similaly as described previous page, you have to copy and edit the run_**.csh file.
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1-3. How to update MagRO1-3. How to update MagRO1-3. How to update MagRO1-3. How to update MagRO

To update MagRO, user can replace with the old directory of MagRO-NMRView with new one.

You can confirm the version of MagRO-NMRView on window header of the startup module;

or you can find it on the window header of main module;



1-5

1-4. Initial setup of MagRO1-4. Initial setup of MagRO1-4. Initial setup of MagRO1-4. Initial setup of MagRO

If you start MagRO-NMRView, you will see the follwoing window;

If you have not set any project before, the program will ask you to setup sequence of sample with the

following popped up windows;

To load protein sequence file, you have to select library. Click AddChain -> Library: protein_res.lib;

Then the window will change;

To load protein sequence file, press "File:" button. The sequence should be described in 1-let code in a textThe sequence should be described in 1-let code in a textThe sequence should be described in 1-let code in a textThe sequence should be described in 1-let code in a text

file.file.file.file. If you load the file, you will see the sequence in the textbox;

  

Any space, tab and return codes will be ignored. The sequence should not be included non-standard amino

acid. To finish the setting up, press "Start setup".
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1-5. Detail of the startup window1-5. Detail of the startup window1-5. Detail of the startup window1-5. Detail of the startup window

1) To add spectrum files1) To add spectrum files1) To add spectrum files1) To add spectrum files

The listbox on the left-side of startup window lists spetrum files populated in the working diretory (in the

sample case, /home/naohiro/nv_PH8/matrix)

To add the spectrum file to the file name entry, firstly activate one of the target entry, then double-click oneTo add the spectrum file to the file name entry, firstly activate one of the target entry, then double-click oneTo add the spectrum file to the file name entry, firstly activate one of the target entry, then double-click oneTo add the spectrum file to the file name entry, firstly activate one of the target entry, then double-click one

of the spectrum file in the listbox.of the spectrum file in the listbox.of the spectrum file in the listbox.of the spectrum file in the listbox.

If you would like to use the added spectrum file, press check-box in the left side of the target entry.

The startup module uses the following names of NMR spectrum;

name of spectra in startup full name of spectra
2D 15N HSQC 2D 1H-15N HSQC
2D 13C HSQC-all-aliph 2D 1H-13C HSQC for allregion or apliphatic
2D 13C HSQC-aro 2D 1H-13C HSQC for aromatic

HNCO 3D HNCO
HNCACO 3D HN(CA)CO
HNCOCA 3D HN(CO)CA
HNCA 3D HNCA
CBCA(CO)NH 3D CBCA(CO)NH
HNCACB 3D HNCACB
HBHA(CO)NH 3D HBHA(CBCA)(CO)NH
CC(CO)NH 3D C(CC)(CO)NH
H(CCCO)NH 3D H(CC)(CO)NH

15N NOESY 3D 1H-15N HSQC NOESY
13C NOESY 3D 1H-13C HSQC NOESY for all region or apliphatic
13C NOESY arom 3D 1H-13C HSQC NOESY for aromatic

HCCH-COSY 3D H(C)CH-COSY for aliphatic
HCCH-TOCSY 3D H(C)CH-TOCSY for aliphatic
CCH-TOCSY 3D (H)CCH-TOCSY for aliphatic
HCCH-COSY arom 3D H(C)CH-COSY for aromatic
HCCH-TOCSY arom 3D H(C)CH-TOCSY for aromatic

If you do not find spectrum type in the above list, you can use "other1, other2...."

Entry for file name
Check box to use spectrum

file listbox
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2) Short-cut nmaes for NMR spectra used in MagRO2) Short-cut nmaes for NMR spectra used in MagRO2) Short-cut nmaes for NMR spectra used in MagRO2) Short-cut nmaes for NMR spectra used in MagRO

MagRO uses short-cut names of NMR spectra as shown below. They are used in control UIs of MagRO

system.

Short-cut names Spectrum names
hsqc 2D 1H-15N HSDC
chsqc 2D 1H-13C HSQC for allregion or apliphatic
chsqc-ar 2D 1H-13C HSQC for aromatic

hnco 3D HNCO
hncaco 3D HN(CA)CO
hncoca 3D HN(CO)CA
hnca 3D HNCA
cbcaconh 3D CBCA(CO)NH
hncacb 3D HNCACB
hbhaconh 3D HBHA(CBCA)(CO)NH
hnhahb 3D HNHAHB
ccconh 3D C(CC)(CO)NH
hccconh 3D H(CC)(CO)NH

nnoesy 3D 1H-15N HSQC NOESY
cnoesy 3D 1H-13C HSQC NOESY for allregion or apliphatic
cnoesy-ar 3D 1H-13C HSQC NOESY for aromatic

hcchc 3D H(C)CH-COSY for aliphatic
hccht 3D H(C)CH-TOCSY for aliphatic
ccht 3D (H)CCH-TOCSY for aliphatic
hcchc-ar 3D H(C)CH-COSY for aromatic
hccht-ar 3D H(C)CH-TOCSY for aromatic
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3) "Sync Jump" function3) "Sync Jump" function3) "Sync Jump" function3) "Sync Jump" function

There are three attributes for "SyncJump" fuction in MagRO;

Sync Jump attribute Corresponding stectrum type

15N 1H-15N

13C-al 1H-13C for all region or aliphatic

13C-ar 1H-13C for all region or aromatic

The spectrum windows whose sync-jump attribute are same can be synchronized by the Sync-Jump

command.

For example, if you specify 3D-HNCACB and 3D-15N-edite NOESY with sync-jump attribute 15N, all the

spectrum windows will display 2D- spectrum region corresponding to the HN-15N position on HSQC plane.

If you change the HN-15N position to the other position (from A to B), all the spetra will dislplay 2D-

spectrum strip as synchronizedly moving HN-15N position.

Sync-Jump corresponding to the

signal position A on HSQC

HN ->

A
B

C

Sync-Jump corresponding to the

signal position B on HSQC
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If you look at the startp up window, you will find the following buttons;

If you press 15N, 13C-al and 13C-ar, you can switch sync-jump attribute of the stratup window.

1H-1H spectra 13C-aliphatic spectra

13C-aromatic spectra15N spectra
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4) Detail settings on startup window4) Detail settings on startup window4) Detail settings on startup window4) Detail settings on startup window

You can set threshold, width and aspect of the spectrum strip

Press "Save" button to save the current settings.

strip width (ppm)

aspect ratio

threshold
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5) Optimizing strip width and aspect ratio for Sync-Jump5) Optimizing strip width and aspect ratio for Sync-Jump5) Optimizing strip width and aspect ratio for Sync-Jump5) Optimizing strip width and aspect ratio for Sync-Jump

You can set width and aspect ratio on the startup window for displaying 2D spectrum strips controlled by

Sync-Jump command.

Firstly you should play around the values for width and aspect.

For the 2D- spectrum;

width: 0.5

aspect: 80

width: 1.0

aspect: 80

width: 1.0

aspect: 20

width: 1.0

aspect: 200
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And 2D spectrum strips extracted from 3D spectra, "width" is corresponding to the X-dimension width for

the 2D spectrum strip, while "aspect" controls aspect ratio of X- and Z-dimension width.

If you flip the 2D-strip by y-axis by pressing "90º filp" button, you can confirm the aspect ratio is optimized.

    

width: 1.5width: 1.5width: 1.5width: 1.5

XZ axis flipXZ axis flipXZ axis flipXZ axis flip

width: 1.0width: 1.0width: 1.0width: 1.0 aspect: 10aspect: 10aspect: 10aspect: 10 aspect: 20aspect: 20aspect: 20aspect: 20 aspect: 2aspect: 2aspect: 2aspect: 2
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6) Start MagRO6) Start MagRO6) Start MagRO6) Start MagRO

To start MagRO, press "start MagRO" button.

(starting MagRO without pressing "save", the setting will be automatically saved)

7) offset correction of 7) offset correction of 7) offset correction of 7) offset correction of 13131313C signalsC signalsC signalsC signals

If 13C offsets are systematically shifted for all the spectra used for MagRO analysis, user can specify the

offset value correction in the entry.

The offset correction will be applied to the input files for the program such as TALOS and FLYA

which are all sensitive to the systematic error in chemical shift table.
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1-6. Switching sync jump mode on spectrum window1-6. Switching sync jump mode on spectrum window1-6. Switching sync jump mode on spectrum window1-6. Switching sync jump mode on spectrum window

Buttons for switching sync-jump modes on all the spectrum windows used in MagRO.

Normally, there are two modes for the spectrum windows, "Silent" and "Sync-Jump". On the other hands,

the 2D-HSQC type spectrum windows have three modes, "Silent", "Sync-Jump" and "Click and Jump".

In the "Sync-Jump" mode, 2D spectrum windows and 2D spectrum strips extracted from 3D spectra with

the same sync-jump attribute display part of spectrum at same position on 2D HSQC plane.

In the "Click and Jump" mode, 2D spectrum window act as clickable HSQC map. If you click 2D spectrum

window, you can move the display region of 2D-spectrum windows and 2D spectrum strips with the same

Sync-Jump attribute.

In the "Silent" mode, the spectrum window will be insensitive to any sync-jump action.

1-7. Fixed mode for XY aspect ratio for 2D spectrum strip
Usually 2D strip displays full region of spectrum on y-axis. To fix aspect ratio for x- and y-dimension, activate check
box on the bottom of spectrum window.

Sync-Jump modeSync-Jump modeSync-Jump modeSync-Jump mode Click and Jump modeClick and Jump modeClick and Jump modeClick and Jump mode Slient modeSlient modeSlient modeSlient mode
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1-8. Conversion of NMRPipe format to NMRCiew format and axis order of spectrum

MagRO-NMRView system can handle only spectrum data in NMRView format.

To convert NMRPipe format into NMRView format, user can use NMRPipe.

Follwoings are the example of macro command for the conversion

xyz2pipe -in /home/naohiro/NMRPipe/ft/n15noe_%03d.ft3 -x -verb ¥

| pipe2xyz -out n15noe.nv -nv -ov

If you execute the macro, you will see the following output and you will get the converted file;

  555  1024  32  18  32    1   31   1 500.13  3257.16    4.80  614.00 H

  256   256  16  16  16   18   15   5 500.13  6756.76    4.80  128.00 HN

  128   128   8  16  16  288    7   9  50.68  1315.79  120.12   64.00 N

[Importnat] You will have to check axis order from the standard output. Above exmaple showing axis order[Importnat] You will have to check axis order from the standard output. Above exmaple showing axis order[Importnat] You will have to check axis order from the standard output. Above exmaple showing axis order[Importnat] You will have to check axis order from the standard output. Above exmaple showing axis order

is H-HN-Nis H-HN-Nis H-HN-Nis H-HN-N

For the analysis with MagRO system, 15N or 13C dimension for 3D spectrum should be set Z-axis.

For example;

Sync-Jump Spectrum types Axis order

15N HNCO, HNCACB, CBCACONH HN-C-15N
15N edited NOESY, H(CCCO)NH HN-H-15N

13C HCCH-TOCSY, 13C-edited NOESY HC-H-13C

For all above examples 15N and 13C dimension is set Z-axis and the indirect dimension are set Y-axis.

If you find the converted spetrum data is need to be transposed, you have to execute NMRPipe macro as

follwoings;

xyz2pipe -in /home/naohiro/NMRPipe/ft/n15noe_%03d.ft3 -x -verb ¥

| pipe2xyz -out n15noe.nv -nv -ov

Instead of the above macro example, you can use TP commandto

transpose the spectrum data.

[Important] User have to be careful to check axis order of HCCH-[Important] User have to be careful to check axis order of HCCH-[Important] User have to be careful to check axis order of HCCH-[Important] User have to be careful to check axis order of HCCH-

TOCSY spectrum.TOCSY spectrum.TOCSY spectrum.TOCSY spectrum.

左の図のスペクトルでは X 軸が H、ｙ軸が観測核(direct dimension)、

Z軸が 13C核になっています。

The left figure shows the example of HCCH-TOCSY spectrum.

In this case axis order is set H-HC-13C.

Please note that the dimension for acquisition is set X-axis.
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1-9. Axis labeling and sychronizing curosor (cross hair)

The function of sychronizedly moving cursor (cross-hair) is an important for NMRView.

This is useful for checking signal position using multiple spectrum window by pointing the corss-hair.

To use the function the axis of spectra should be set same axis labeling.To use the function the axis of spectra should be set same axis labeling.To use the function the axis of spectra should be set same axis labeling.To use the function the axis of spectra should be set same axis labeling.

As shown in the above example, The y-axis of 3D HCCH-TOCSY is labeled with "H", while the y-axis of 3D

15N edited NOESY is also labled with "H".

If you find the cross-hair is not moving synchronizedly, you have to check axis labeling for each spectrum on

the Pref window. You can open the Pref UI window by pressing the button "Pref" on the header of spectrum.

You can change the axis labeling and save the information.

。

You can temporary set the axis labeling using Attribut window. By mouse-right-button -> attribute -> View

to open Attribute window, you can change the axis labeling.

HCCH-TOCSY 15N-edited NOESY

Cross hair is
synchronizedly moving
for y-axis

NMRView C-version NMRView Java-version
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1-10. Directories and files used for MagRO system

The project diectories and files included under the matrix directory

matrix -----------|
|
MagDB

    protein_0_0_acs.db  Assigned chemical shift table

    protein_0_0_seq.db sequence table

backup    Backup directory

xpkfiles    Peka list (xpk file) direcotry

CYANA_results    Storing files for CYANA result analysis

000temp    directory for temprary files

The most importand directory is MagDB. The directory has the file for assigned chemical shift table

(*_acs..db) and sequence table file (*_seq.db).

It is strongly recommended that user should take the backup of the directory periodically.

000temp has several temprary files for setting window size and position. The directory can be deleted if you

have some problem to display window UIs.

The directory "CYANA_results" includes temporary files which can be recreated automatically. So user can

delete them if necessary.
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1-11. Detailed instruction of Main window of MagRO
When you start MagRO, you will see a small window UI as shown below;

　Quit: Quit MagRO system

　SetSpec: Display startup module window

　Call NMRView: Recover NMRView UI system

　Acs Main: Popup Acs module

　Acs Editor: Popup Acs Editor module

　BackBone: Popup Backbone Assignment Module (BBAM)

　PSR: Popup Patern Search Robot (PSR)

To popup spectrum window, you can select and double-click one of the spectrum type listed in the listbox

placed in the center of module. The short-cut names are used for selection of spectrum as defined in the

Startup module (see section 1-5 2) page 1-6).

The 90deg flip buttons are used to flip 2D-spectrum strips for each sync-jump attribute.

The Z-axis of 2D spectrum strips can be inter- changed by clicking the button between the direct dimension

(HN or HC) and heavy atom dimension (15N or 13C).

By pressing the button "SetSpec" user can call Startup module to define sync-jump settings of spectrum.

Using the module you can add spectrum window which has not yet been loaded.

Recover NMRView UIs

Select and popup spectrum windows

90deg flip buttons

Call Acs module

Call Acs editor windowCall BBAM module

Call PSR module

Call startup module
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2-1. Backbone signal assignment2-1. Backbone signal assignment2-1. Backbone signal assignment2-1. Backbone signal assignment

1) required spectra1) required spectra1) required spectra1) required spectra

for the backbone signal assignments, the following spectra are required.

name of spectrum symbol of spectrum atom type Axis order

3D HNCO hnco CO(i-1) HN-C-N

3D HN(CA)CO hncaco CO(i) HN-C-N

3D HN(CO)CA hncoca Cα(i-1) HN-C-N

3D HNCA hnca Cα(i) HN-C-N

3D CBCA(CO)NH cbcaconh Cβ(i-1) HN-C-N

3D HNCACB hncacb Cβ(i) HN-C-N

Above list describes required spectra and its symbolic name which are used in spectrum manager.

In the analysis of backbone signal on MagRO, atom types are important as listed above. For example,

the spectrum window, HNCACB is used to get chemical shift value of Cβ signal on residue i-th, but

CBCACONH window is used to get the value of Cβ signal on residue (i-1)th.

[Caution][Caution][Caution][Caution] When you prepare 3D-spectrum from FID, Please make sure the order of axis is correctly set,

otherwise MagRO can not properly display the spectrum strips. (For example HNCO should have axis

order proton[1], carbon[2] and nitrogen[3]).

[Caution][Caution][Caution][Caution] DO NOT USE same axis label. This will cause error when you save peak list into xpk file.

Please use different axis label for each dimension;

          (Bad)  HN C13 C13

         (Good)  HN C13 C
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2) Prepare HN-15N peak list2) Prepare HN-15N peak list2) Prepare HN-15N peak list2) Prepare HN-15N peak list

For the backbone signal analysis, firstly you have to prepare HN-15N peak list.

Select "hnco" in the top window and double-click to popup the HNCO spectrum window.

3) optimize spectrum threshold3) optimize spectrum threshold3) optimize spectrum threshold3) optimize spectrum threshold

Touch the HNCO spectrum window to activate it.

Press up- and down-key to move z-dimension and to display several peaks.

Then press R- and F-key to optimize spectrum threshold not to display too much nose.

Now you can press "Peaks" button to open "MagRO Simple Peak Manager".

double-clickdouble-clickdouble-clickdouble-click
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4) Start peak picking4) Start peak picking4) Start peak picking4) Start peak picking

Press "AutoPicker" button in the "MagRO Simple Peak Manager",

In the Auto peak picker window, chage the name of out put file as hnco.xpk;

Then press "Peak picker", the automated peak picking will began.

5) Load peak list5) Load peak list5) Load peak list5) Load peak list

Find the created peak list file. For example nv_demo/matrix/hnco.xpk.

To load the peak list file, press File->Load xpk (see left panel).

Select loaded peak list, hnco (see middle panel).

Press "DrawPeaks" button to display peak boxes (see right panel).

As shown in the right panel, detected peaks just on 2D-plane are indicated bu blue boxes, while the

boxes near the 2D-plane are green.
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If you look at the header of spectrum window, you will find buttons to switch cusor mode.If you look at the header of spectrum window, you will find buttons to switch cusor mode.If you look at the header of spectrum window, you will find buttons to switch cusor mode.If you look at the header of spectrum window, you will find buttons to switch cusor mode.

As shown in the above figure, there are four buttons; "normal mode", "add peaks", "adjust position andAs shown in the above figure, there are four buttons; "normal mode", "add peaks", "adjust position andAs shown in the above figure, there are four buttons; "normal mode", "add peaks", "adjust position andAs shown in the above figure, there are four buttons; "normal mode", "add peaks", "adjust position and

size of peak box" and "peak delete".size of peak box" and "peak delete".size of peak box" and "peak delete".size of peak box" and "peak delete".

[TIPS] press W, A, D and S keys to move the spectrum region up, left, right and down, respectively.[TIPS] press W, A, D and S keys to move the spectrum region up, left, right and down, respectively.[TIPS] press W, A, D and S keys to move the spectrum region up, left, right and down, respectively.[TIPS] press W, A, D and S keys to move the spectrum region up, left, right and down, respectively.

[Caution] There is no undo function for peak delete mode, so please carefully to handle the cursor.[Caution] There is no undo function for peak delete mode, so please carefully to handle the cursor.[Caution] There is no undo function for peak delete mode, so please carefully to handle the cursor.[Caution] There is no undo function for peak delete mode, so please carefully to handle the cursor.

<If you mistakenly deleted peak box...><If you mistakenly deleted peak box...><If you mistakenly deleted peak box...><If you mistakenly deleted peak box...>

Open the MagRO Simple Peakmanager, select peak list that you would like to edit.

Activate the checkboxes "show only deleted" and "jump to peak" (left panel).

Press < > buttons to move and display peaks.

Find the peak that you have deleted, and press "pirate" button to recovery from the status "deleted".

6) Save edited peak list to xpk file6) Save edited peak list to xpk file6) Save edited peak list to xpk file6) Save edited peak list to xpk file

To save the edited peak list into a xpk file, press "Tools" button

then select "Get-Int,Cmp&Degap,Write".

This action will get intensity of all peaks, compressing peak list (permanently delete peaks),

degaping the peka ID numbers and write peak list to xpk file. You will be asked the file name of output

file, you should type "hnco.xpk", then overwrite the old xpk file.

[important] [important] [important] [important] you have to keep saving the peak list in hnco.xpk which will be used for making HN-15N

peak list.

normal mode

peak delete

adjust position and size of peak box

add peaks
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7) Create HN-15N peak list table, assign_NN.txt7) Create HN-15N peak list table, assign_NN.txt7) Create HN-15N peak list table, assign_NN.txt7) Create HN-15N peak list table, assign_NN.txt

Press "Setup" button on the yellow module (BBAM, Back-Bone Assignment Manager). If you don't find

the yellow module, press "Backbone" button on the top window.

You will be asked to make sure what you are going to do, press "Yes".

If you don't see any error message, the setting job has been sucessfully completed.

8) Edit information tored in assign_NN.txt file8) Edit information tored in assign_NN.txt file8) Edit information tored in assign_NN.txt file8) Edit information tored in assign_NN.txt file

If you press "<" or ">" button, you will see the number of

peak ID are incrementing and decrementing. At the same

time, spectrum windows with 15N sync-jum attribute are

also moving to the corresponding HN-15N position in

HSQC projection..

IF you press "ShowID" in the yellow module, blue boxes appear in the spectrum windows. They

indicate peak positions expected from assign_NN.txt file.
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You can edit assign_NN.txt using a standard text editor.

Peak ID number should not be consecutive, but should not be duplicated. Please use positive number

for Peak ID. The number of column should be important. Lacking of column number may cause serious

error.

Next thing to do is removing peak ID derived from minor peaks and noise peaks.

By pressing "ShowId" button on the header of yellow module, blue boxes are displayed on HSQC

spectrum window. Then press "del" button on the header of HSQC spectrum window to change the

cursor to deletion mode. By clicking blue boxes you can delete the Peak ID derived from noise peaks.

To save the peak ID in assign_NN.txt, press "SaveID" button on the header of HSQC spectrum

window.

9) Loading assign_NN.txt file9) Loading assign_NN.txt file9) Loading assign_NN.txt file9) Loading assign_NN.txt file

If you check the directory matrix/backup, you will see the backuped file of assign_NN.txt as

assign_001.txt, assign_NN.002, assign_NN.003... and so on.  Click "Editor" button on the header to

open "MagRO Assignment Table Manager", and click File->Open to load the old assign_NN.txt file.
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10) Test of sync-jum and fine tuning of spectrum offset10) Test of sync-jum and fine tuning of spectrum offset10) Test of sync-jum and fine tuning of spectrum offset10) Test of sync-jum and fine tuning of spectrum offset

To test the Sync-Jump function, align the spectrum 2D strips as shown above.

Peass "<" and ">" and "15N 90>>" buttons on yellow module to see what happen.

Next,try to move cursor and cross-hair lines are moving.  If the y-axis line does not seem to be moving

synchronizedly, check the axis labeing are same.

To edit the axis label, press "Pref" button on the header of spectrum window to open pref-edit UI.

You can optimize spectrum offset for each axis on the pref-edit UI.

90deg flip 90deg flip 90deg flip 90deg flip 15151515N Sync-JumpN Sync-JumpN Sync-JumpN Sync-Jump
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11) Full-automated making of peak ID table11) Full-automated making of peak ID table11) Full-automated making of peak ID table11) Full-automated making of peak ID table

Followings are steps for making peak ID table in automated manner

Minimum set of spctraum data

3D-HNCO or 3D-HN(CO)CA

And you may use the follwing data set

3D-HNCO, HN(CA)CO, HN(CO)CA, HNCA, CBCA(CO)NH, HNCACB, C(CO)NH

To perform the automated peak ID table making, press "Setup" button on the header of yellow module.

Then a dialogue window will popup and ask you if you are sure to do the job.

 IF you answer yes, a small window UI will popup;

In the window UI, if you select "Auto ID making", the program will create peak ID table including

only HN and 15N chemical shift information. If you select "Auto fill CACBCO", the program will

create peak ID table including all chemical shift data, HN, 15N, CA(i), CA(i-1), CB(i), CB(i-1), CO(i)

and CO(i-1).

Then you press "Setup" button, again the small UI will ask if you are sure to start program. If you

answer "Yes", the program will start creating the peak ID table (normally it will take a few mins).

In the middle of yeallow module, there is a button to get CO,

CA and CB chemical shifts for each peak ID.

1

2
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12) Enter chemical shift value to yellow module12) Enter chemical shift value to yellow module12) Enter chemical shift value to yellow module12) Enter chemical shift value to yellow module

For the backbone signal assignment, next thing to do is complete the chemical shift table.

By clicking mouse middle button, user can insert chemical shift value of y-axis on 2D spectrum strip.

Make sure which atom type can be correspond to the spectrum type from the labe on the bottom of

spetrum window.

Try to click mouse-middle-buttonon on HNCO, the chemical shift value will be inserted in the entry

corresponding to atom type CO(i-1).

Do not forget to save the entered values, by pressing "Save""Save""Save""Save" button.

If you fill the entries for atom types, CA and CB, you can predict residue type by pressing "Predict""Predict""Predict""Predict"

The predicted amino acid types are displayed in the entry boxes for (i-1) left and (i) right neighboring

"Predict" button, showing one-letter code and ordering is heigher probability.

The predicted amino acid type are based on statistic information of The predicted amino acid type are based on statistic information of The predicted amino acid type are based on statistic information of The predicted amino acid type are based on statistic information of chemcal shifts for Ca and chemcal shifts for Ca and chemcal shifts for Ca and chemcal shifts for Ca and CbCbCbCb

derived from BMRB database. If your NMR spectrum is derived from BMRB database. If your NMR spectrum is derived from BMRB database. If your NMR spectrum is derived from BMRB database. If your NMR spectrum is systematicallysystematicallysystematicallysystematically shift, set value of the 13C shift, set value of the 13C shift, set value of the 13C shift, set value of the 13C

correction on Startup module.correction on Startup module.correction on Startup module.correction on Startup module.

By pressing """"ShowId"ShowId"ShowId"ShowId" button, you will confirm the entered chemical shift values with blue boexs on

2D- spectrum strips.

mouse middle clickmouse middle clickmouse middle clickmouse middle click
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13) Function to search for candidate sequential peak IDs13) Function to search for candidate sequential peak IDs13) Function to search for candidate sequential peak IDs13) Function to search for candidate sequential peak IDs
If you press "Search <" or "Search >" button, based on the entered checmial shift values for Cb, Ca and

CO the program will search for peak ID of sequential position (i-1) or (i+1). This function directory

uses spectrum intensity for the search, this will be very powerful to find overlapped peaks in crowded

region.

The default state, the program will search;

(i-1)(i-1)(i-1)(i-1) Peak IDPeak IDPeak IDPeak ID (i+1) Peak ID(i+1) Peak ID(i+1) Peak ID(i+1) Peak ID
CO: HN(CA)CO HNCO
Cα: HNCA HN(CO)CA

Cβ: HNCACB CBCA(CO)NH

You can enable or disable atom types for the search with

the checkboxes in the left side of yellow module.

The detected Peak IDs will be displayed in the listboxes

below the search button in higher probability order.

The most probable Peak ID indicated by bold. If the peak

IDs already assigned are displayed with residue type (1-

letter code) and residue number in parentheses.

If you activate the checkboxes CO, CA and CB on

right-side of yellow panel (red ellipse), then double click

one of the searched peak IDs, 2D spectrum strips will

appear showing corresponding peak ID position.

The left-bottom example showing sequential PeakID 14

of HN(CA)CO which has been searched for sequentila

(i-1) residue of peak ID 15.

Similarly, if you double click the searched peak ID

(Peak ID 3) for sequential residue (i+1), you will see the

popuped 2D strip showing HNCO.

By carefully inspeting the signals in the popuped strips

with one in the current 2D strip, you can easily find

which peak ID should be assigned sequential residue.

HNCO, PeakID 15

HN(CA)CO, PeakID 14

HNCO, PeakID 3

HN(CA)CO, PeakID 15

(i-1) search(i-1) search(i-1) search(i-1) search

(i+1) search(i+1) search(i+1) search(i+1) search

double clickdouble clickdouble clickdouble click
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14) sequential assignments using MAGRO Assignment Table Manager14) sequential assignments using MAGRO Assignment Table Manager14) sequential assignments using MAGRO Assignment Table Manager14) sequential assignments using MAGRO Assignment Table Manager

If you press "Editor" button, you will see the following window.

This editor displays assignment information of backbone signals using the peak ID table,

assign_NN.txt file.

1: Manipulation of file

2: Execute "QuickAssign"

3: Execute "CheckAssign" to validate assigned results

4: Execute "Show Seqgment" to confirm and correct sequential assignments using 2D-strip array.

5: Switch increment and decrement for sort function

6: Translation of assigned data to Acs (Assigned Chemical Shifts)

7: Trnaslation of assigned data to Acs and automated assignment of Hα and Hβ signals

8: Display "Sequence Board" to check assignment completeness, to delete sequential assignments

9: Execute "Quick Save" to save assignment information to assign_NN.txt file.

10: Undo and redo button

11: Sort buttons for residue number, residue type, Peak ID, chemcial shifts

1 2 3 4 85

11109

6 7
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If you press "Sequence" button on the yellow module, you will see a small window as hown above.

1: "Unassigned" Unassign"  User can unassign the residue when "Select Res" is activated.

2: Checkbutton to switch the sequence board to residue selection mode

3: To select all residue, press "All" button

4: Reset button to reset residue selection

5: Amino acid composition buttons. If you press one of them, the sequence button highlighted with the

selected amino acid type.

If you activate "Select Res" then press one of the button on the sequence board, the button color will

change gray. Then if you press "Unassign" button, the selcted residues will be unassigned in the peak

ID Table (residue number willl be 9999). This action will not delete chemical shift information.

2

3

4

5

1

residue type

residue number Unassigned residue should be "999"

one-letter amino acid type should not contain space

Peak ID Peak ID number shold not be duplicated

chemica shifts for HN, 15N, Cαααα, Cββββ, CO
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15) Automated sequential assignment using "15) Automated sequential assignment using "15) Automated sequential assignment using "15) Automated sequential assignment using "QuickAssign"QuickAssign"QuickAssign"QuickAssign"

If you press "QuickAssign" button on the MagRO Assignment Table Manager, you will see the

following window

1: correction value of 13C chemical shift. You can add the value for the automated assignment

2: Execute automated sequential assignment by Quick Assign

3: Tolerance values of CO, Ca and Cb chemical shifts for automated assignment

4: fix user defined sequential assignments

5: Penalty value for each segment. For trustful assignment the value should be below 5.0.

6: Begin and end residue number of the segment

7: Peak ID segment obtained from automated sequential assignment. The segment with penalty

value higher than 10.0 may not appear.

By pressing "QuickAssign" button, the program will perform sequential assignment using peak ID

table, assign_NN.txt. The program will connect peak IDs whose CO and CA and CB chemical shifts

are smaller than the tolerance value and will generate segments of peak IDs. By checking amino acid

types predicted from CA and CB chemical shifts for each segments and comparing with the amino acid

sequence, the program will search the best segments. The calculation of the assignments will take a

few seconds depending on the size of protein.

[Important][Important][Important][Important] If several blanching segments are found in the results, there might be minor signals in the

peak ID table. In this case the minor you have to remove peak IDs derived from minor signal.

5

1
2 3 4

6
7
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If you double-click one of the segments, you will see the small window;

The window display the detinal of the sequential assignments;

If you press "Assign" button, you can fix the sequential assignments then the color of the segment in

the QuickAssign module will change to blue.

Pnalty value Assign
Unassign

User defined assignments

Assigned residue number

Peak ID

chemical shift difference

amino acid type
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Now you can fix all the assignments for the segments with the penalty value less than 5.0. If you lucky

enough, you can complete 60~80% of the sequential assignments

If you would like to perform further assignments, enabling the checkbox "fix user assign" and run the

QuickAssign is good idea

If you disable the check button, you only see the following segments,

If you activate "fix user assign", now you can see longer segments and additional short segments;
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16) manual sequential assignment16) manual sequential assignment16) manual sequential assignment16) manual sequential assignment

Using yellow module, user can assign residue number manually.

Enter assigned residue number in the entry "Resno:" in

the middle of yellow module as shown in the left panel.

[Caution] Do not enter duplicate residue number, it will[Caution] Do not enter duplicate residue number, it will[Caution] Do not enter duplicate residue number, it will[Caution] Do not enter duplicate residue number, it will

cause serious error.cause serious error.cause serious error.cause serious error.

17) 17) 17) 17) Unassign assigned residue numberUnassign assigned residue numberUnassign assigned residue numberUnassign assigned residue number

In the peak ID table file, assign_NN.txt, residue number is set to 9999 for unassigned peak IDs.

    98 Q S   108  7.935 113.664 176.927 173.545 57.251 58.839 25.865 60.502 - - -

    99 S C 109 7.577 118.443 173.545 999.990 58.839 999.990 60.502 999.990 - - -

   100 P S 115 8.428 116.081 999.990 174.416 60.860 60.111 31.242 60.097 - - -

   101 S S 116 8.5990 116.794 174.416 172.145 60.111 56.059 60.097 61.633 - - -

   102 S S 9999 8.511 117.864 172.465 172.803 55.926 56.231 61.618 61.620 - - -

If you would like to unassign the assigned residue number for a peak ID, open sequence board by

clicking "Sequence" button on the yellow module to open BBass Seuqnce Board. Then activate "select

res" check button, you can select the residues that you would like to unassign.

The selected buttons are clored by dark gray, then press "Unassign" to unassign the selected residues.



2-16

18) Validation and correction of sequential assignments using "18) Validation and correction of sequential assignments using "18) Validation and correction of sequential assignments using "18) Validation and correction of sequential assignments using "CheckAssign"CheckAssign"CheckAssign"CheckAssign"

By pressing "Check Assign" button on the MAGRO Assignment Table Manager, you will see the

window UI;

This window tells you if there is some errors and warnings found in the sequential assignments.

Typical errors are significant difference between CO, Ca and Cb chemical shifts for assigned residues

(i) and (i-1) or (i+1), mismatching residue type predicted from Ca and Cb chemical shifts, and

duplication of residue numbers.

The messages for warnings are indicated by black and serious errors are indicated by red.

Large difference between chemical shifts of CO(i) and CO(i-1) （0.3~1.0 ppm）

Seriously large difference between chemical shifts of CA(i) and CA(i-1)（>1.0ppm）

Duplicated residue numbers are assigned two peak IDs

Chemical shift value is missing of CA for sequentially assigned residues

Mismatching amino acid type of assigned residue with sequence

If no error has been found
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If you double-click one of the erro or warning message, you will see a window displaying 2D spectrum

array;

The above example is showing the assigned chemical shifts for CA(Arg61) and CA(Thr62) is significant.

The arrayed spectrum strips can help you to recognize which assigned signals is wrong.

By clicking mouse-right-button on the spectrum position of y-axis and pressing "Save" button, you can

correct the wrongly assigned chemical shift value directoly.

double-clickdouble-clickdouble-clickdouble-click

where the problem found

HN(CO)CA, PeakID 24 assigned as Thr62

HNCA, PeakID 48  assigned as Arg61

mouse-right-clickmouse-right-clickmouse-right-clickmouse-right-click
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19) Confirmation of sequential assignments using show segment function19) Confirmation of sequential assignments using show segment function19) Confirmation of sequential assignments using show segment function19) Confirmation of sequential assignments using show segment function

If you press "Show Segments" on the MAGRO Assignment Table Manager, you will see a small window

UI listing all possible sequential assignment segments. Select one of the display option among CO, Cα,

Cβ, Cα/Cβ, Hα/Hβ, NOE, then double-click one of the segement to show spectrum strip array;

[Important] For each display option, you need to prepare required spectrum windows. For example

CA/CB mode requires spectrum windows for CBCA(CO)NH and HNCACB.

[[[[deteil of the header of segment display window]deteil of the header of segment display window]deteil of the header of segment display window]deteil of the header of segment display window]

double clickdouble clickdouble clickdouble click

CBCA(CO)NH HNCACB

You may have to check

selected PeakID

entered chemcial shift value

Save information

90deg flip for z-axis

Display peak position

inc- dec-residue number
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20) Finishing sequential assignments and data 20) Finishing sequential assignments and data 20) Finishing sequential assignments and data 20) Finishing sequential assignments and data tranportation to Acs module.tranportation to Acs module.tranportation to Acs module.tranportation to Acs module.

If you would like to finish the sequential assignments and to transport the data to Acs module, press

"Editor" button on the yellow module to open MAGRO Assignment Manager and press "ExportAcs"

button to start the job.

When the data transfer job is completed, you can find a text file "protein_0_0_acs.db" in the directory

matrix/MagDB.

[Caution] This action will overwirte the old assignment data with new one. Please take a backup of

MagDB directory before starting the job.

If you have not seen any error message, you will see the magenta module can display assignment

information. The below left panel shows the assigned chemical shifts for the residue GLY12.

The job will fill the chemical shift values of HN, CA , CB and CO signals. If the signals for both (i) and

(i-1) residues are avilable, the averaged values will be entered.

If you press "Assign" button on the HSQC spectrum, you will see assigned peak positions are displayed

by blue boxes in the spectrum window.
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21) Export assigned chemical shifts to Acs with automated assignment of H21) Export assigned chemical shifts to Acs with automated assignment of H21) Export assigned chemical shifts to Acs with automated assignment of H21) Export assigned chemical shifts to Acs with automated assignment of Hαααα and  and  and  and HHHHββββ signals signals signals signals

In the previous section, you have learned how to export the assigned chemical shifts for backbone

signals. This section will describe how to export the data to Acs with automated signal assignments for

Hα and Hβ signals.

For the exportation and assignment job, the following spectrum data is required;

Spectrum name Short cut name in MagRO

2D 1H-13C HSQC for aliphatic chsqc

3D HBHA(CO)NH hbhaconh

To execute the program, firstly you have to open "MAGRO Assignment Manager" by clicking "Editor"

button on the yellow module. Then press "Export HBHA" button.  The assignment job takes 10-20sec.

Depending on spectrum quality, the accuracy of assignments will be around 70%.

After the exportation and assignment jobs, you can confirm and correct the assigned chemical shifts,

for example if you press "Assign" buttons on 2D-1H-15N HSQC, 2D 1H-13C HQSC and HBHA(CO)NH

the blue boxes appear on the spectrum windows indicating the assigned signal position. Now you can

check the assignments one by one by clicking increment- decrement- residue number button on the

yellow module.

[important][important][important][important] In many cases, methylene group such as Hb2 and Hb2 close together in y-axis in

HBHA(CO)NH spectrum are assigned as degenerate signal. In such this, you have to separate them

and treat as ambiguously assigned signals on Assigned Chemical Shift Editor.

To correct the assignments, firstly you have to set residue number (i) on the MagRO-ACS module and

double-click one of the atoms that you would like to edit, "Assigned Chemical Shift Editor" will appear.

Secondly, you have to display 2D-spectrum strip of HBHA(CO)NH, then then press "Assign"  button

on the header of spectrum window. Thirdly, set the residue number (i-1) on the yellow module. Now

you can enter chemical shift value to the editor by clicking mouse-middle-button on y-axis of

HBHA(CO)NH spectrum window.
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3-1. Assignments of aliphatic side-chain signals3-1. Assignments of aliphatic side-chain signals3-1. Assignments of aliphatic side-chain signals3-1. Assignments of aliphatic side-chain signals

1) required spectra1) required spectra1) required spectra1) required spectra

name axis-order axis-label

3D HCCH-TOCSY for aliphatic 1H-1H(acq)-13C HC-H-C

3D HCCH-COSY for aliphatic 1H-1H(acq)-13C HC-H-C

3D 1H-13C edited-NOESY for aliphatic 1H(acq)-1H-13C HC-H-C

CC(CO)NH, H(CCO)NH and HCCH-COSY would be helpful but should not be enough. For the side-

chain signal assignments, HCCH-TOCSY must be required.

[Important] User has be careful to set axis order and axis labeling. If they are wrongly set, the system

may not work properly.

2) How to use 2) How to use 2) How to use 2) How to use MagRO-Acs moduleMagRO-Acs moduleMagRO-Acs moduleMagRO-Acs module

This module is used for managing assigned chemical shift table.

You can find the path of working directory as shown in the upper

panel indicated with red ellipse.

To move the residue number that you want to display, type

residue number in the entry then press return key.  You can

increment and decrement the residue number by pressing

buttons "<" and ">" on the module.

If you can move to the residue number whose residue type can be

specified in the "Residue: Name" entry.

If you press sequence button, you will see a small window to

display the sequence of your sample as shown in the right panel.

In the window, the residues whose signal for HN and 15Nα have

been assigned are indicated by cyan.

If you press one of the button in the sequence window, you can

move to the assignment table of the selected residue number.

If no signals has not been assigned, the Acs module

shows atom name and chemical shifts for statistically

averaged values indicated with gray characters as

shown in the left panel .

残基番号エントリ残基番号エントリ残基番号エントリ残基番号エントリ

Dec. residue no.

Inc. residue no.

Residue type
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3) How to enter chemical shift value3) How to enter chemical shift value3) How to enter chemical shift value3) How to enter chemical shift value

To enter chemical shift value to the Acs module, firstly you have to open chemical shift editor by

double-clicking one of the atom type listed in the module.

Secondary you have to place y-axis of the cross-hair cursor just on the peak that you would like to get

the chemical shift value. Now by middle-button-click on spectrum window, you can enter chemical

shift value directly.

Above example showing how to enter chemical shift value from y-axis of 2D spectrum strip. You can

change to x- or z-axis by clicking checkboxes on the editor.

DO NOT FORGETDO NOT FORGETDO NOT FORGETDO NOT FORGET to press "Update" button to update the

all information in the MagRO system.

Press "Save CS"Press "Save CS"Press "Save CS"Press "Save CS" button on the Acs module to save and fix

the chemical shift information.

  

If you successfully finish the assignment job for a certain signal of atom, you will find the atom line in

the module turn to be cyan.

If you would like to If you would like to If you would like to If you would like to unassign unassign unassign unassign the information, select

"Unassign" checkbox on the editor, then press , then press , then press , then press Update

button to update the information. To finalize the

operation, don't forget to press "Save CS" button.

double-clickdouble-clickdouble-clickdouble-click

mouse middle button clickmouse middle button clickmouse middle button clickmouse middle button click
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It is possible to save the information after several times

of pressing update button assignment.

You can retrieve the old assignment state by pressing

"undo" button on the editor.

The Acs module has a function to display warning or

error message if the assigned chemical shift is largely

away from averaged chemical shift value: S.D.*2>

warning (orange) and S.D.*3> error (red).

If the signal that you would like to assign is in aliased

area of spectrum (State-TPPI mode), you have to

calculate the real chemical shift using offset and

spectral width. In this case you have to select up or

down for the aliased shift and type 1 or 2 in the "fold:" entry. The editor will calculate the real chemical

shift automatically. All you have to do is trying up or down and change the value for fold (1 or 2).

If the procheral proton or carbon signal (such as Hβ2 and Hβ3 of Ser, Cγ1

and Cγ2 of Val) have not been assigned stereo-chemically, you have to

specify the assignments are "ambiguous". In this case you have to select

"ambig" on the editor. If the procheral signals are overlapped, select

"degen" which means signals are degenerate.

The information of assigned chemical shifts are saved in the directory;

~/nv_data/matrix/MagDB

You can find chemical shift table file, protein_0_0_acs.db which can be opened by standard text editor.

The format is tabular style;

AtomID　Atom Residue No CS value Ambiguity code

560 NH GLY 41 8.410 1

561 N GLY 41 112.500 1

562 CA GLY 41 43.500 1

563 HA1 GLY 41 4.450 3

564 HA2 GLY 41 4.450 3

565 O GLY 41 999.990 0

566 C GLY 41 176.200 1

The chemical shift values for unassigned signals are 999. The ambiguity code indicates the ambiguity

of assignment for procheral atoms.  The value means 0 for "not assigned, 1 for "assigned", 2 for

"ambiguously assigned" and 3 for "signals degenerate".

[important] It would be [important] It would be [important] It would be [important] It would be recommendedrecommendedrecommendedrecommended that user periodically take the backup. that user periodically take the backup. that user periodically take the backup. that user periodically take the backup.
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4) Assignments of H4) Assignments of H4) Assignments of H4) Assignments of Hαααα and  and  and  and HHHHββββ signals signals signals signals using backbone assignment moduleusing backbone assignment moduleusing backbone assignment moduleusing backbone assignment module

required spectra: HBHACONH, 2D 1H-15N HSQC, 2D 1H-13C HSQC

In most cases you can assign most of all signals using HBHA(CO)NH.

Firstly you have to set residue number (i-1) on Acs module.

By double-clicking to open editor for the signals Hα or Hβ.
Then set the target residue number using the yellow module to display HB/HA region of 2D spectrum

strip of HBHA(CO)NH.

For example, set the y-axis of cross-hair cursor just on Hβ signal and mouse-middle-click to get the

chemical shift value. As you don't now which Hβ signal is R- or S-configuration, you have to select

"ambig" checkbox on the editor. If the Hβ signals seem to be overlapped, you have to select "degen".

Finally press "Update" button on the editor and "Save CS" button

on the Acs module to complete the assignment job.

[Important] If many HN-15N signals are crowded in HSQC plane,[Important] If many HN-15N signals are crowded in HSQC plane,[Important] If many HN-15N signals are crowded in HSQC plane,[Important] If many HN-15N signals are crowded in HSQC plane,

try to flip 2D-spectrum try to flip 2D-spectrum try to flip 2D-spectrum try to flip 2D-spectrum strp around X-Z dimension by clickingstrp around X-Z dimension by clickingstrp around X-Z dimension by clickingstrp around X-Z dimension by clicking

15N 15N 15N 15N deg flip button.deg flip button.deg flip button.deg flip button.

The left panel showing X-Z flipping of 2D epctrum strip of

HBHA(CO)NH spectrum.

double-clickdouble-clickdouble-clickdouble-click

HN-15N 15N-HN
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You can confirm the assigned chemical shifts on spectrum window. Press "Assign" button on the

header of 2D 1H-13C HSQC spectrum, the expected signals will be displayed as blue boxes on the

window.
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5) extension of carbon signal assignment for aliphatic side-chain5) extension of carbon signal assignment for aliphatic side-chain5) extension of carbon signal assignment for aliphatic side-chain5) extension of carbon signal assignment for aliphatic side-chain

required spectra: CC(CO)NH, 2D 1H-15N HSQC, 2D 1H-13C HSQC

Let us assume that we have already finished to assign Cα and Cβ
signals. Here we ready to assign Cγ, Cδ  and Cε signals using CC(CO)NH.

The left panels show 2D spectrum strips of CBCA(CO)NH and CC(CO)NH for
1H-15N position of Thr at residue (i-1).

[Important]

1. The peaks observed in CC(CO)NH spectrum are sometimes slightly

shifted positions because of sample heating by spin-locking.

2. Some of signals in CC(CO)NH are missing especially for larger

protein.  Broad signals will be also weak and sometimes missing in

the spectrum.

3. Cβ and Cγ signals of Pro residue for cis conformer give largely

different chemical shifts from standard value.

The aliphatic side-chain signals for the other residues, Glu, Ile, Lys,

Leu, Met, Pro, Gln, Arg and Val can be assigned using standard

chemical shift value.

The left panels show

typical aliphatic side-

chain signals observed

in CC(CO)NH

spectrum.

If you press "Assign"

button on the

spectrum window you

can confirm the

assigned chemical

shifts by visual

inspection of blue

boxes displayed on

expected peak

positions.

CCCCγγγγ2 methyl2 methyl2 methyl2 methyl

CCCCββββ

CCCCαααα

CBCACONHCBCACONHCBCACONHCBCACONH CCCCCCCC（（（（COCOCOCO））））NHNHNHNH

Glu
Gln

Pro
Arg

Val Ile LeuMet Lys
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6) extension of proton signal assignment for aliphatic side-chain6) extension of proton signal assignment for aliphatic side-chain6) extension of proton signal assignment for aliphatic side-chain6) extension of proton signal assignment for aliphatic side-chain

required spectra: HCCH-TOCSY for aliphatic (hccht), 2D 1H-13C HSQC (chsqc)

Here we are going to learn how to extend proton signals of the aliphatic side-chain using  HCCH-

TCOSY, 13C edited NOESY (CNOESY) and tool implemented in MagRO.

Prior to the assignment works, the signals of Cα, Cβ, Hα, Hβ and Cγ have been already assigned.

Select and show the assignments for the residue Leu14 by typing 14 and

press return on magenta module (upper and left panel)

Then double-click HB3 to display assignment editor for the signal Leu14-

Hβ  (upper and right panel).

Prepare 2D spectrum strip of 3D HCCH-TOCSY for aliphatic (hccht) and

click "Jump: 13C-al" button on the editor. Now the 2D spectrum strip

displays the region corresponding to the signal of Leu-Hβ-Cβ  on 1H-13C

HSQC (left panel).

double-clickdouble-clickdouble-clickdouble-click
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The "PSR" button on the main module to open PSR module.

Now click the check button "Pattern" in the PSR module, the module will change the GUI formation as

shown below;

Place the cross-hair cursor just on one of the signals on HCCH-TOCSY. By mouse-middle-button

clicking, chemical shift values of the y- and z-axis will be inserted in the PSR module.
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Now you can press "Search" button the PSR module to search for diagonal peaks in HCCH-TOCSY

with peaks with the same chemical shifts on x-axis.

The left panel shows an example searching for

diagonal peak (19.72ppm on Z-axis) with the

chemical shifts -1.81ppm on X-azis.

The search function can detect diagonal peaks with

the 80% of threshold set to the HCCH-TOCSY

spectrum window.

If you double-click one of the search results (the

left panel example only showing single result) to

popup another 2D spectrum strip corresponding to

the X-Z position of the search result.

X: -1.81ppm

Z: 19.72ppm

double-clickdouble-clickdouble-clickdouble-click

Original strip

Similar peak patternSimilar peak patternSimilar peak patternSimilar peak pattern

Searched strip
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If you find the peak patter is similar in the found 2D spectrum strip, you can assign the signal as

side-chain signal of Leu14.

Next, open 1H-13C HSQC spectrum for aliphatic

(chsqc), then expand the region near -1.81ppm

and 19.71ppm. If you find an unassigned signal

near the position, it should be remaining signals,

Hγ/Cγ, Hδ1*/Cδ1 or Hδ2*/Cδ2. From the chemical

shift value of Y-axis (19.71ppm), the most

probable assignment should be Hδ1*/Cδ1.

The standard chemical shift value can be found in

Acs module as the values with gray color.

To complete the assignment, double-click the

HD11 in the Acs module, then place the cross-hair

cursor just on the signal in HSQC and mouse-

middle-click to enter the chemical shift value of x-

axis (proton). Press "Update" button to update the

Acs information, then close the editor.

Next thing to do is double-click CD1 in the Acs

module to open editor. Click the check-box of y

and place the cross-hair cursor just on the signal

in HSQC. By mouse-middle-clicking, enter the

chemical shift value of y-axis (13C) to the editor.

Don't forget to press "Update" to update the Acs

information.

If the 13C dimension is folded, the program will automatically predict unfolded chemical shift using

offset and spectrum width.

To finish the assignment press "Save CS" button on the Acs module.To finish the assignment press "Save CS" button on the Acs module.To finish the assignment press "Save CS" button on the Acs module.To finish the assignment press "Save CS" button on the Acs module.

[Important] If the spectrum width has been very narrow, the prediction of folded chemical shift will be

failed. In that case, user has to specify the aliasing way (up-file or down-filed) and folding times on the

editor widow the try to enter the chemical shift value by mouse-middle-button clicking.
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7) How to assign signals of aliphatic side-chain with no HN-15N information

 required spectra:HCCH-TOCSY for aliphatic, 1H-15N edited NOESY, 1H-13C edited NOESY,

                2D 1H-13C HSQC for aliphatic

In this section, we will try to assign the signals of aliphatic side-chain if the backbone assignment

information for their residues is not available.

The example will be focused on the assigments of Hγ and Hδ signals at Pro66 in the sequence Thr65-

Pro66, providing that the assignments of all signals in Thr65 and Hα and Hβ  Hα, all carbon signals of

Pro66 have been finished.

To identify the Pro configuration, you have to check the status1 in the Acs module. The program will

automatically predict the cis/trans configuration of Proline from the chemcal shift difference between

Cβ and Cγ signals.

                         

The example of this section Pro66 is trans.

If the Pro isin trans configuration, you can observe strong

NOEs between Hα(i-1) and Hδ(i) signals as shown in the

left panel. (while Pro is in cis configuration, strong NOEs

between Hα(i-1)- Hα(i) signals can be observed).

Now we are going to confirm the

configuration and assign Hδ signals.

Firstly, press "C&J" button on the

bottom of spectrum window of 1H-13C

HSQC for aliphatic (chsqc) and expand

the region for Hδ-Cδ signals.

Prepare 2D spectrum strip of 13C-edited

NOESY, and set cross-hair cursor on one

of the signals of Hδ-Cδ signals without

assignment.

In the example (left panel) you can find

strong NOE peaks around 4.6ppm.

Press "PSR" button on the main window

to open PSR module.

Place y-axis of the cross-hair cursor just

on the observed strong NOE and press

muse-middle-button to enter the

chemical shift value in the PSR module.

C

O

Cα
H

N

H

Cα N

O

C Cα

H2Cδ
CγH2

CβH

H

H

Strong NOE Hα(i-1) - Ηδ(i)

Weak NOE HΝ(i-1) - Ηα(i)

NOE Pro65HNOE Pro65HNOE Pro65HNOE Pro65Hδδδδ-Thr65H-Thr65H-Thr65H-Thr65Hαααα

click and jumpclick and jumpclick and jumpclick and jump

predicte as trans predicted as cis can't say cis/trans
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Press "Search" button to search proton chemical shifts in

the assigned chemical shift table.

The left panel shows the search results.

The closest peak is Thr65-Hα, indicating the signals on

chsqc are considered to be Hδ-Cδ signals in Pro66.

Now you can assign the signals are Hδ-Cδ on the chsqc, input

the chemical shift values Hδ and Cδ signals in Acs

module similar to the method explained in the previous

section.

To confirm the assignment, you can popup spectrum strip

array for intra-residual assignments by pressing "2D-

strip" button on the Acs module (below panel).  Using

the spectrum array you can check assignments by

inspecting peak patters are similar among the 2D strips

displaying X-Z positions saved in assigned chemical shift

table.
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8) How to assign unassigned methyl signals8) How to assign unassigned methyl signals8) How to assign unassigned methyl signals8) How to assign unassigned methyl signals

required spectra: HCCH-TOCSY for aliphatic, 2D 1H-13C HSQC for aliphatic

Firstly open the spectrum window of 2D 1H-13C-HSQC for aliphatic (chsqc), then click the right

button in the bottom of spectrum window to switch "C&J" mode.

Then open 3D- HCCH-TOCSY for aliphatic (httht), press "Assign" button in the chsqc. Expand chsqc

spectrum window to display methyl signal resuin and search for the signals without assignments.

The below left panel shows a signal without assignment in the methyl signal region, place the cross-

hair on the signal and click the window.  The C&J function makes hccht display corresponding

spectrum region.

Then Open PSR module, press "Pattern" checkbox. Place cross-hair cursor on the larger signal in hccht

(0.80ppm), press "Search" button. The program will find most probable diagonal peaks in hccht and

list them in the PSR module.

Double-click one of the search results (22.69ppm) to display corresponding 2D spectrum strip in

HCCH-TOCSY (right panel). If you find the diagonal peak showing similar peak pattern, the signal

should be the side-chain signal of target residue. Try to search other representative signals in the 2D

strips using PSR module to identify the residue number of the signal. You can complete the

assignments of the methyl signal as described in the previous section.

Click and jumpClick and jumpClick and jumpClick and jump
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3-2 How to assign aromatic signals3-2 How to assign aromatic signals3-2 How to assign aromatic signals3-2 How to assign aromatic signals
1) 1) 1) 1) required spectrarequired spectrarequired spectrarequired spectra

Spectrum name axis order axis label

2D 13C-HSQC for aromatic  1H(acq)-13C HC-C

3D 1H-13C HSQC-NOESY for aliphatic 1H(acq)-1H-13C HC-H-C

3D 1H-13C HSQC-NOESY for aromatic 1H(acq)-1H-13C HC-H-C

If your 13C edited NOESY measured for all carbon regions (aliphatic and aromatic), you have to

specify the spectrum as both 13C-NOESY for aliphatic and aromatic in the startup module.

2)  assignments of aromatic signals using PSR module2)  assignments of aromatic signals using PSR module2)  assignments of aromatic signals using PSR module2)  assignments of aromatic signals using PSR module

The most important step for the assignments of aromatic signals is finding NOEs between Hβ-

H atoms.  Prior to this job,  the assignments of Hβ-Cβ  signals should have been finished.

Firstly, press "Sync" button on the bottom of spectrum window of 2D 1H-13C HSQC for aromatic (chsqc-ar).
The button will change to C&J (Click and Jump mode).

Then open the 2D spectrum strp of 13C-edited NOESY for aromatic(c13noe-ar) and expand the region of Hδ-Cδ 
signal region.
In the chsqc-ar window, then place the cross-hair curser just on the signal that you want to analyze the click
mouse-left button.  The 2D spectrum strip of c13noe-ar will display corresponding X-Z position as shown in
the right panel.

Next, press "PSR" button on the main module to open PSR module.
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Click the checkbox "NOEs" (blue eclipse in the below panel) in the PSR module to switch the

module to NOE search mode.

The below left panel shows the 2D spectrum strip of 3D 13C-edite NOESY for aromatic (c13noe-

ar)displaying the NOEs from target Hδ-Cδ  signal. Place cross-hair cursor on one of the strong

NOE which might be from Hβ signal and press mouse-middle button to enter the chemcial shift

value in the entry of PSR module.

If the checkbox is enabled "NOEs", the program will check the intensity of 13C-edited NOESY on

the trnased position.  The above example showing the NOEs observed on Tyr41-Hδ-Cδ. The search

results on the PSR module are showing the closest proton atoms found in assigned chemical shift

table, Tyr41-Hβ2 and His43-Hβ2. On the transposed position of the NOE peak in the left panel,

namely the position of 3.286ppm in y-axis on the X-Z position of Tyr-Hβ-Cβ (colored by blue), the

signal intensity is detected greater than 80% of the threshold value set for the 13C-edited NOESY.

You can confirm the NOE peak pattern in the 2D-spectrum of transposed position by double-

clicking the search results listed in PSR module. The 2D-spectrum strip corresponding to the

transposed position will appear (right panel).

Using this function, you can assign the aromatic side-chain signals.

mouse-middle clickmouse-middle clickmouse-middle clickmouse-middle click

double-clickdouble-clickdouble-clickdouble-click
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3-3 Confirmation of assigned chemical shifts using a function to display 3-3 Confirmation of assigned chemical shifts using a function to display 3-3 Confirmation of assigned chemical shifts using a function to display 3-3 Confirmation of assigned chemical shifts using a function to display 2D spectrum array2D spectrum array2D spectrum array2D spectrum array

Required spectraRequired spectraRequired spectraRequired spectra: : : :     15N-edited NOESY, 13C-edited NOESY

If you press "2D-stripes" button on the Acs module, the window as shown in the right lower panel

will popup.  In the window, the spectrum 2D regions of X-Z positions corresponding assigned

chemical shifts of atoms in selected residue such as HN-15N, Hα-Cα and so on.

Detail of the header of "2D-sterip array window"Detail of the header of "2D-sterip array window"Detail of the header of "2D-sterip array window"Detail of the header of "2D-sterip array window"

1: 1: 1: 1: Execute automated side-chain signal assignment for the current residue

2: 2: 2: 2: Current residue number,  3: 3: 3: 3: Inc- and Dec-number of residue ID

4: 4: 4: 4: Chemical shift value  5: 5: 5: 5: "Save" button to save the edited chemical shifts in Acs table

6: 6: 6: 6: "Show" button to show blue boxes in 2D-strip array

7: 7: 7: 7: "none" button to erase blue boxes in 2D-strip array

8: 8: 8: 8: 90 deg-flip button to flip X-Z dimension of 2D-strips.

1 2 3 4 5 6
7

8

15N-NOESY

13C-NOESY aliphatic
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Using the 2D-spectrum strip array, you can confirm the assigned chemical shifts with NOE peak

patters in 15N- and 13C-edited NOESY. It is easy to find wrongly assigned chemical shift if the NOE

peak pattern of one of the 2D strip which is largely different from those observed in the other

strips.

If you would like to correct the chemical shifts, place the x-axis of the cross-hair cursor just on the

signals that you consider correct position, and click mouse-middle-button. The detected chemical

shift value will be displayed in the entry of header of the 2D-strip array window.  Then you press

"Save" button to save the information in Acs table.

mouse-middle-click Press "Save"  button to save the
information to Acs table
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3-4 Fully automated assignment of side-chain aliphatic and aromatic signals3-4 Fully automated assignment of side-chain aliphatic and aromatic signals3-4 Fully automated assignment of side-chain aliphatic and aromatic signals3-4 Fully automated assignment of side-chain aliphatic and aromatic signals

1) 1) 1) 1) for aliphatic and aromatic side-chain signalsfor aliphatic and aromatic side-chain signalsfor aliphatic and aromatic side-chain signalsfor aliphatic and aromatic side-chain signals    of selected residueof selected residueof selected residueof selected residue

RequirementsRequirementsRequirementsRequirements: : : : 13C-edited NOESY, HCCH-TOCSY for aliphatic and HCCH-COSY for aromatic

                        Assigned chemical shifts for  Hα-Cα and Hβ-Cβ

Before run the automatic assignments, set the threshold of spectrum windows properly.

Open the 2D-spectrum strip array window and press "Auto assign" button on the header of window.

The assignments will take a few seconds. The accuracy and completeness of the automated

assignments are around 80~90% and 70~80%, respectively, which are strongly depending on the

quality of spectra.



5-4

2) 2) 2) 2) for all residuesfor all residuesfor all residuesfor all residues

Please make sure that you have prepare spectrum windows as followings:

Requirements for aliphatic signalsRequirements for aliphatic signalsRequirements for aliphatic signalsRequirements for aliphatic signals::::

Assigned chemical shifts for Hα-Cα, Hβ-Cβ in Acs module are completed

3D 1H-13C NOESY for aliphatic

3D-HCCH-TOCSY for aliphatic

Requirements for aromatic signalsRequirements for aromatic signalsRequirements for aromatic signalsRequirements for aromatic signals::::

Assigned chemical shifts for Hα-Cα, Hβ-Cβ in Acs module are completed

3D 1H-13C NOESY for aromatic (or covering all regions)

3D-HCCH-COSY for aromatic

Before run the automatic assignments, set the threshold of spectrum windows properly.

press "Tools" button on the header of Acs module to open the pull-down menu, then select

"Automated assign *".  The automated assignment program will begin and assign the side-chain

signals one-by-one. The average calculation time should be around 2~3 mins for 100 residue long

protein.  The accuracy and completeness of the calculation are similar to the function mentioned

previous page.

[Important ] While running the calculation, you can not manipulate MagRO.
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11. CYANA setting module

1) Files for CYANA calculation
The module for creating CYANA calculation input files is now available from the magenta module (ACS). The

settings are mostly automated, user will be released from the annoying works such as conversion of file format,

checking version dependency, and so on.

<Requirements>

At least one NOE peak table, 3D-NOESY and ACS directory

<out-put files>

CALC.cya, int.cya defines CYANA calculation parameters such as constrain file names, violation

tolerances, library names, stereo chemistry settings, etc.

*.seq sequence file.  Can be specified cis-Pro, Cystine and t-His (library should support
them).

*.prot chemical shift table (now support only one *.prot file).

talos.aco phi, psi angle constraints derived from TALOS prediction (pred.tab required)

*.peaks supports 1H-1H-15N and 1H-1H-13C xpk files.
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2) Quick start CYANA input maker

If you click the button "Plugins" on the left-top of the magenta module, you will see a pull-down menus;,

Select "Export CYANA input files" among the menus to open startup window;

Type the sample name and the path name for CYANA calculation and select version of CYANA as shown

above panel.

Then press "Next" button to open the main-setting window



9-3

The initial state of the setting entries are empty.  If you don't know whato to do, please try to press

"AutoSet" button, the automated setting program will fill the entries.

If the settings seem to be OK, then press "MakeAll" button (blue circle) to make all input_files.

You can also make each input_file by pressing "Make" button (green circle) on each file setting section.

And if you would like to edit the created file, click "Edit" button to open the text file editor

By pressing the "SaveDefault" button, you can save the current setting as default for the next calculations ,
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3) Details of the input file sections

A) Chemical shift table:

For the chemical shift table file, *.prot, the GUI stuffs are;

The chemical shift values are loaded from the ACS files, matrix/ACS/acs.*.  The 15N and 13C chemical shift

values for the signals on the folded region of 3D-NOESY spectrum are calculated using the NOESY spectrum

parameters if the spectrum dependencies are defined in the entry "depend:".  The example shown above

indicates, ubiq.prot file <--> NOE:1 and NOE:2.

B) NOE peak table:

For the NOE peak table file, *.prot, the GUI stuffs are;

The most recently edited xpk file is automatically found and typed in the "input file" entry.  User has to define

the name and path of the output-file in the "*.peaks file" entry  Currently user can specify three NOE peaks

files, 1H-1H-15N NOESY, 1H-1H-13C NOESY for aliphatic and aromatic regions.
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C) CALC.cya and init.cya files:
The GUI stuffs for making CALC.cya and init.cya files,are found on the bttom gray zone of the module as

shown below.

For the settings for calculation;

1: number of CPU for the CYANA calculations. [default 10]

2: residue numbers for fitting calculated structures. [default begin-residue-1 - end-residue]

3: number of structures for calculation [default 100]

4: number of steps for calculation [default 10000]

5: number of selected structures [default 20]

6: confine mode distance constrain [default disable]

7: automated aco file making [default disable]

8: call child module for setting user defined files for CYANA calculations

9: button to make CALC.cya and init.cya files

10 & 11: buttons to call for text-editor windows

And for the stereo chemistry settings;

1: left listbox to show the procheral atoms found in the chemical shift table, ACS. The atoms

colored by blue indicate the stereo-checmistry is defined to include CYANA calculations

2: reload the stereo-chemical atoms from ACS

3: add and delete the elements listed in the right-side listbox

4: right listbox to define the stereo-specific assigned atoms used for CYANA calculations

5: If you select "stereo", only stereo-specifically assigned atoms are loaded when you reload

ACS.  If you select "ambig", the atoms whose stereo-chemistry is ambiguous are loaded.  If you

select "dege", all procheral atoms are loaded.

1

2

8 9
11

5 6 7

10

3 4

1
2 4

5
3
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4) If you want to use custom files that you have made such as *.upl, *.lol, *.aco and *.lib files.....
User is allowed to specify the files for additional constrain files and library files.  If you

click the button on the section for setting CYANA input files (red circle), you will see a child

window.  You can define the file name and path in the listbox for the following files;

*.upl file for upper limit distance constraints

*.lol file for lower limit distance constraints

*.aco file for dihedral angle constraints

*.lib library file for atom coordinate

.

1: entry to define the path name of the target file

2: add button used to add the defined path name to below listbox

3: listbox showing files going to be used for CYANA calculation

4: append-lib checkbox.  If it is checked, the listed library file will be appended to

the standard library file for CYANA calculation.

5: delete button to delete selected item in the listbox

If you click to execute "MakeInitFiles" button or "MakeAll" button, the CALC.cya and int.cya

files are created with these informations.

1

3

4
5

2
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12. Setup CYANA result analysis module12. Setup CYANA result analysis module12. Setup CYANA result analysis module12. Setup CYANA result analysis module

1) Setup of module1) Setup of module1) Setup of module1) Setup of module
The "CYANA result analysis module" finally supports the official version of CYANA, 2.x.

<<<<RequirementsRequirementsRequirementsRequirements>>>>
CYANA input files and output files;
CALC.cyaCALC.cyaCALC.cyaCALC.cya and init.cyainit.cyainit.cyainit.cya files
cyclecyclecyclecycle*.noa*.noa*.noa*.noa and cycle*.uplcycle*.uplcycle*.uplcycle*.upl files
Spectrum data files, *.nv, for 3D 1H-1H-15N NOESY, 3D 1H-1H-13C NOESY

An example of the CYANA result analysis shown in this page has been performed with the
following data sets;

Sample: ubiquitin
NOESY: 3D 15N edited NOESY, 3D 13C edited NOESY for aliphatic and 

aromatic
NOE peak table: n15.peaks and c13noe.peaks obtained from the NOESY spectra
Chemical shift table: ubiq.prot, refined with the NOESY spectra
CYANA: official release ver 2.1
target NOA: final.noa

To start the setting up the CYANA result analysis, click the "plugins" button on the green module

(SSM) to open the pull-down menus.

Select "CYANA 2.x results analysis".  Then you will see an initial setup window
Type the path name of the CYANA calculations, then press "Load" button to load the information.
The window will change to show additional GUI items;
Press "Setup" to finish the setting up jobs.
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2) Functions of the main window (Row mode)2) Functions of the main window (Row mode)2) Functions of the main window (Row mode)2) Functions of the main window (Row mode)

Representing the NOE assignment results carried out by CYANA for each NOE peaks.

1: Button to switch the window between "Row" and "Sort" modes.

2: Pulldown button to switch NOE peak lists

3: Button to switch between "Assigned" and "Unassigned" NOE peak analysis modes

4: Entry to set NOE peak ID

5: Window header displays version of CYANA and the current path name of *.noa file

6: Increment and decrement buttons for NOE PeakID number

7: Button to open setting window for peak labeling

8: Button to open PSR module

9: Button to open Summary window

10: Button to open main-setting up window.

11: Button to execute 90deg flip of the NOESY spectrum strip

 And options to select PeakIDs are;

1: options to skip NOE peaks within the defined distance range.

2: options to skip NOE peaks within the defined violation range

3: option to skip peaks of "No corresponding signal" and diagonal peaks

4: switch to enable the "twin strips display" "twin strips display" "twin strips display" "twin strips display" to check NOE assignment symmetry

5: option to exclusively show "No corresponding signal" and diagonal peaks

1

2

3

4

107 8 9

11

6
5

5

1 2 43



10-3

3)3)3)3) The Sync-Jump from CYANA analysis moduleThe Sync-Jump from CYANA analysis moduleThe Sync-Jump from CYANA analysis moduleThe Sync-Jump from CYANA analysis module

The module can provide "Sync-Jump" command to control NOESY spectrum strip corresponding to the

selected NOE peakID.  By pressing "Show" button, the target 3D-NOESY spectrum get jumped to the

peak positions  "<" or ">" button increments and decrements peakID number as well as jumps the

target NOESY spectrum.  If checked the option "Sym" (red circle), the module turns to "twin strips

display" mode.  The "Sync-Jump" command displays the spectrum strip corresponding to the

transposed peak position of the NOE assignment.  The function is useful to confirm the symmetrysymmetrysymmetrysymmetry of

the NOE assignment achieved by CYANA.

Symmetry means: if you see one NOE peak between the atoms Trp43-Hb and Leu-Hg, and you are

displaying at 2D strip for the position of Leu-Hg/Cg. Now you are looking at the NOE pathway Trp43-

Hb<-> Leu-Hg/Cg . To confirm the symmetry of the NOE pathway, you would like to display 2D strip for

Trp43-Hb/Cb and whether the NOE peak exists on the 2D strip. The function in the module can detect

the spectrum intensity on the symmetrical position of assigned NOE and can display the corresponding

2D spectrum strip.

Press "show" or "<", ">" button

Double click one of the items

Double click one of the items
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4) Functions of the main window (sort mode)

By pressing "Sort" button on the header of main window, you can switch to "Sort mode" from "Row
mode". In this mode, all of the NOE peaks are listed in the window for the selected peak lists. The most
probable assignment for each NOE peak will be shown. Using the buttons shown with red rectangle, you can sort
the NOE peaks in the listbox.

noeID NOE peak ID
Dist(A) estimated 1H-1H distance (Å)
Voil(A) distance violation (Å)
Y(ppm) Y-axis chemical shift (ppm)
X(ppm) X-axis chemical shift (ppm)
Z(ppm) YZaxis chemical shift (ppm)
XZ Sort for XZ-plane
Atom2(Y) Atom assigned with Y-axis chemical shift. Sorted alphabetical
Atom1(X) Atom assigned with X-axis chemical shift. Sorted alphabetical
Sym_NOA If the NOE symmetrically assigned or not

In this mode, if you double-click one of the NOE peak in the listbox, 2D spectrum strip for the corresponding NOESY

spectrum displaying XZ-region corresponding to the XY-chemical shifts of selected NOE peak. Similar to the Row

mode, if the "sym" checkbutton is enabled, 2D spectrum strip corresponding symmetrical position will appear.

double-click one of the NOE peaks
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5) The most powerful function of the module: 5) The most powerful function of the module: 5) The most powerful function of the module: 5) The most powerful function of the module: Sort&Skip searching for problematic Sort&Skip searching for problematic Sort&Skip searching for problematic Sort&Skip searching for problematic NOEsNOEsNOEsNOEs

The function that mentioned in this chapter must be powerful in the final refinement stage of NMR structure

determination. The most of the NOE peaks assigned by CYANA will be used as distance constraints in structure

calculations. If the intensity of such the NOE peak is not weak, and its assignment symmetry has not been

confirmed, the peak and assignments should be considered to be spurious. If you try to find the spurious NOE

assignments in the cycle7.noa file, it will be a tremendously tedious works.

In the "Sort" of the module, you can find several checkboxes in the module as shown below;

The detailed functions of these checkboxes are as follows;

increasing: Sort increasing way

decreasing: Sort decreasing way

Sym: Skip NOEs having symmetrically assigned NOE

Trans: Skip NOEs having intensity on transposed position

close H2O: Skip peaks close to H2O signal

close diag: Skip peaks close to diagonal peaks

The below panels show more than 2000 peaks which has been assigned by CYANAderived from 13C-edited

NOESY. By enabling the checkboxes, the NOE peaks with trustful assignments are all filtered and only the

spurious NOEs are listed in the module. The inspection of the three spurious NOEs actually disclosed

misassignments in assigned chemical shift table.

enale all chekbox then press "Sort"
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6) Sync-Jump of spectrum strip with fixed region.

A small checkbox can be found on the every 3D-spectrum strip.

By activation of the checkbox, the "Sync-Jump" command from

CYANA result analysis module controls spectrum strips with fixed

window apspect.  This function is usefult to recognize NOE peaks

at desired spectrum aspect ratio.

7) Peak labeling function
If user press "Peak label" button, the setting window will appear.

To run the program, user has to define input and output xpk file names, and then press "Execute" button to finish

the labeling job.

The peak labeling job finishes in 1-2sec for each xpk-file (including ~200 peaks).

The following are how the labeling codes;

Diagonal peak Xdiag

No corresponding signal X0/0

Not assigned, Ala32-Ha <-> Thr55-Hg# X32a/55g#

Assigned, Met103-Hg# <-> Gln29HN 103g#/29n

Assigned intra-residual, Phe67-HB2<->Phe67-HD# b1/67d#
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12. FLYA setup module

1) required files for FLYA calculation

FLYA setup module will help you to generate files required for FLYA calculation. FLYA is a function

implemented in CYANA which can be used for fully automated signal assignment and structure calculation.

Recommended spectrum data sets for backbone signal assignments;

2D 1H-15N HSQC, 3D-HNCO, 3D-HN(CA)CO, 3D-HNCACB, 3D-CBCA(CO)NH

If you have 3D-HNCA and 3D-HN(CO)CA spectra, it would be better idea to include them.

For assignments of all signals including backbone and side-chain atoms;

3D-HCCH-TOCSY for aliphatic, 3D-HCCH-TOCSY for aromatic

3D-15N edited NOESY, 3D-13C edited NOESY for aliphatic and aromatic

If 3D-HBHA(CO)NH, 3D-CC(CO)NH and 3D-H(CCCO)NH are available, it would be better idea to include

them.

FLYA calculation requires spectrum data sets with enough data points. It is strongly recommended that you

shall make double the data points for in-direct dimension and 13C/15N dimension using zero-filling, linear

prediction and non-linear sampling techniques.. The followings are the successful examples of spectrum data

sets;

3D HCCH-TOCSY X: 2048 Y:256 Z:256
15N-edited NOESY X: 1024 Y: 512 Z:256
13C edited NOESY X: 2048 Y:512 Z:256

    

For the FLYA calculation, the following files are required;

RUNFLYA.cya, int.cya Setting files for FLYA calculation.

*.seq Sequence file

*.peaks Peak table file

[Important]

The accuracy of the automated assignments strongly depends on spectrum quality. If you find that the

peaks HCCH-TOCSY and NOESY spectra are significantly overlapped and missing, you will have to

reconsider the plan of signal assignments.

If the assignments are moderately difficult by manual operation, and if the correctly modeled structure

is available, you can run FLYA calculation with the structure and in some case you can get correct

assignments.

[Warning]

Basically, using spectrum included folded peaks (peaks are detected in folded positions) may decrease

accuracy of automated assignments. However, if you have 13C-HSQC for full region (constant time

would be better), the program in MagRO can recover the folded peaks in HCCH-TOCSY and 13C-edited

NOESY in unfolded position.
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2) Lets start FLYA calculation

Press "Import/Export" button on the Acs module, then select "Export/Import Flya files"

Then you will see the setting up window as shown in the left

panel.
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a) Firstly, you have to choice type of assignments, backbone signal only or all signals.

b) Secondary, set the directory path for FLYA calculation. Directly type the path or get the directory by

pressing ".." button. If you would like to create the directory, press "MakeDir" button.

c)c)c)c) Press "Pick All spectra" button to start automated peak picking for all spectra.

[Important]  Before do this job, you have to set spectrum threshold properly for each spectrum

window.

d)d)d)d) You can refold peaks in folded position by pressing "Unfold peaks" button.

[Important] To use this function, you need to prepare spectrum windows for 2D 13C-HSQC for

aliphatic and aromatic region (chsqc and chsqc-ar) which have been acquired without spectrum

folding in 13C dimension.

e)e)e)e) Press "Noise Filter" button to start noise filtration for all peak tables.

Noise filter function will use peak table derived from 2D 15N-HSQC and 13C-HSQC for aliphatic

and aromatic as mask table.

f)f)f)f) To covert the peak table file for FLYA calculation, press "Convert xpk-->FLYA" button.

Select assignment types

Number of CPUs

Path of Job directory

Automated peak picking

Noise filter

file format conversion

Export files for FLYA calculation
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3) Detail of the files created by FLYA setup module

RUNFLYA.cya, A macro file for FLYA calculation. You can describe spectrum names, 
structure file name

init.cya Settings for FLYA calculations such as CPU number, sequence file name, 
library file name, etc.

protein.seq Sequence of target protein. Should be described by three letter codes

***_auto.xpk Peak table identified by auto peak picking

***_filt.xpk Peak table filtered by Noise filter command

***_unfold.xpk Peak table with unfolded peaks

***.peaks peak table in XEASY format

For the conversion of xpk format to XEASY format, program will select the xpk file by the
priority order; ***_refine > ***_unfold > ***_filt  > ***_auto

 [Important] If you edit xpk file, you should overwrite ***_refine.xpk. [Important] If you edit xpk file, you should overwrite ***_refine.xpk. [Important] If you edit xpk file, you should overwrite ***_refine.xpk. [Important] If you edit xpk file, you should overwrite ***_refine.xpk.

             For example, hncacb-al_refine.xpk.             For example, hncacb-al_refine.xpk.             For example, hncacb-al_refine.xpk.             For example, hncacb-al_refine.xpk.

4) Execute FLYA calculation

You can start FLYA calculation on the job directory using following command;

/opt/cyana3.95/cyana RUNFLYA

The calculation time using 4CPUs is 5~10min for backbone signals and 60min for all signals.
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5) Import results of FLYA calculation

After the FLYA calculation you will find an assigned chemical shift table as flya.tab.

In this table the most important parameter is "inside" on the 5th column. The value estimate the

frequency of the assigned chemical shift value in the calculation. The FLYA module will pick up

the assigned chemical shifts with the value above 80% (labeled with strong) as they are trustful

enough.

To import the results of FLYA calculation for backbone signals, press "Import FLYA->BBass"

button and for all signals press "Import FLYA-->ACS" button.

After the import, the program will overwrite the assigned chemical shifts in assign_NN.txt file

for backbone signals and ACS table MagDB/protein_0_0_acs.db file for all signals, respectively.

[Important] The assigned chemical shifts in assign_NN.txt and MagDB/protein_0__acs.db will[Important] The assigned chemical shifts in assign_NN.txt and MagDB/protein_0__acs.db will[Important] The assigned chemical shifts in assign_NN.txt and MagDB/protein_0__acs.db will[Important] The assigned chemical shifts in assign_NN.txt and MagDB/protein_0__acs.db will

be overwritten with imported be overwritten with imported be overwritten with imported be overwritten with imported valuesvaluesvaluesvalues. Please make sure to take backup of the files before do this. Please make sure to take backup of the files before do this. Please make sure to take backup of the files before do this. Please make sure to take backup of the files before do this

job.job.job.job.

Backbone signals All signals

    Total number of shift values: 32057

    Cutoff for extent           : 16.00

  

    Atom  Residue      Ref   Shift     Dev  Extent  inside   inref

    N     ARG    3         116.353            20.0    55.7     0.0

    H     ARG    3           8.181            20.0    54.3     0.0

    CA    ARG    3          59.572            20.0    99.8     0.0  strong

    HA    ARG    3           3.795            20.0    99.7     0.0  strong

    CB    ARG    3          29.085            20.0    99.7     0.0  strong
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11) Handling peak list
a)  howto load peak list

MagRO has a original peak list manager.

You can find "Peaks" button for each spectrum

window as swhon in the left panel.

The left pane shows Peak manager of 3D HNCO

spectrum.

[Important] If you open a peak module for a

spectrum window, they are linked each other. Please

confirm which spectrum is linked to the peak

module.

If you want load xpk file, press "File" button on the module, then

select "Load xpk".  Now you can load xpk file that you want to

load.

To display peak boxes on the spectrum window, press button just

right side of "Peak list:", then select peak list name that you have

loaded. Press "Draw Peaks" button to display peak boxes on

spectrum window.
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2) How to change cursor mode (add, delete and adjust peaks)

User can change the mode of cross-hair cursor by pressing the buttons on the header of spectrum

window as shown above.

[Important] To edit the peak list using above buttons, user has to set peak list that has been[Important] To edit the peak list using above buttons, user has to set peak list that has been[Important] To edit the peak list using above buttons, user has to set peak list that has been[Important] To edit the peak list using above buttons, user has to set peak list that has been

previously generated. If you wish to create peak list, just work up as described below.previously generated. If you wish to create peak list, just work up as described below.previously generated. If you wish to create peak list, just work up as described below.previously generated. If you wish to create peak list, just work up as described below.

[Appendix] To create peak list

　　　　　　　　NMRView C versionNMRView C versionNMRView C versionNMRView C version

　　Click the mouse-right-button just on the spectrum window to open menu then select "peak".

Write name of the peak list in the entry of "List Name:"  Click "pick" button to create peak list

and to start automated peak picking.

    NMRView Java versionNMRView Java versionNMRView Java versionNMRView Java version

　　Click the mouse-right-button just on the spectrum window to open menu, then selct

"Attribute". Select "PeakPick" tab and write name of the peak list in the entry of "List". Click the

"Pick" button to start automated peak picking.

3) How to delete and adjust peak box.3) How to delete and adjust peak box.3) How to delete and adjust peak box.3) How to delete and adjust peak box.

Please be careful to delete peak boxes. The deleted peaks disappear immediately but actually no

deleted permanently from the peak list. You can recover the deleted peak anytime if you want

(see the naext page).

In the adjustment mode, you can move the position of peak boxes and change their size

manually.

　　NMRView C versionNMRView C versionNMRView C versionNMRView C version

　　By clicking just on the peak box and dragging it, you can move the peak box. At the same

time, by clicking mouse-middle-button and dragging the peak box, you can change the size of

peak box.

　　NMRView Java versionNMRView Java versionNMRView Java versionNMRView Java version

　　Click the peak box with the mouse-left-button just on the peak box. The peak box will turn to

be yellow. Click the moues-left-button near the center of peak box you can move the peak box. if

you click the mouse-left-button near the edge of the peak box you can change the size of peak box.

Delete peaks

Adjust peak boxPeak addition
normal
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3) How to save peak list

Firstly, make sure the current peak list has been

selected in the "Simple Peak Manager".

In the "Simple Peak Manager", press "File -> Save

xpk", you can save the peak list as *.xpk file.

If you want to remove the "deleted" peaks

permanently from the peak list, Press

Tools-> Get-Int,Cmp&Degap,Write. This

command will compress the peak list and

degap the numbering of peaks.

4) How to recover "deleted" peaks

Firstly you have to set peak list that you

want to manage now in the "Peak list:".

Enable the checkboxes "show only deleted"

and "jump to peak".  Press "＜" and "＞"

buttons to increment and decrement the

number peak ID and find the deleted peak

that you want to recover. If you find the

target peak labeled with "deleted" just

neigbour the pirate button, press the pirate

button. The deleted peak will be recovered

and peak box will appear in the spectrum

window.
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7-1. Trouble shootings7-1. Trouble shootings7-1. Trouble shootings7-1. Trouble shootings

1) I can't see some window because the window position might be out of screen.1) I can't see some window because the window position might be out of screen.1) I can't see some window because the window position might be out of screen.1) I can't see some window because the window position might be out of screen.

If you change the screen size of desktop, some window can be found anywhere. In this case, try to delete the

000temp directory and restart MagRO.

matrix/000temp

2) I can't open CYANA result analysis module2) I can't open CYANA result analysis module2) I can't open CYANA result analysis module2) I can't open CYANA result analysis module

Some error will cause to fail to open CYANA result analysis module properly.

Please try to delete CYANA_results directory and try to open the module again.

matrix/CYANA_results

3) I can't type anything in entries of 3) I can't type anything in entries of 3) I can't type anything in entries of 3) I can't type anything in entries of MagRO systemMagRO systemMagRO systemMagRO system

If MagRO system seems to be working without any error message, sometime you can not type anything in

the entries implemented in modules of MagRO system. The conflict of input method (especially Japanese

input method) with NMRView Cversion has been reported long time ago. Please disable any input method

on your desktop manager.
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